
CLEAREDITS CLEAN UP USER GUIDEWRITING IMPROVEMENT PRODUCTS

ClearEdits® Clean UpTM is a utility that lets writers work with documents contain-
ing ClearEdits’ writing improvement advice that they received from coworkers, col-
leagues, professors, and others. With ClearEdits Clean Up, writers can review, act
on, and then remove ClearEdits’ suggestions, without a license to use ClearEdits.
ClearEdits Clean Up is available as a free download from http://www.clearwriter.com.

ClearEdits®—a software tool that works with Microsoft® Word and Outlook®—applies
powerful editing techniques to a document, suggesting improvements in clarity and
readability in a fraction of the time it takes to edit without assistance. ClearEdits’ intu-
itive interface allows writers to move quickly from suggestion to suggestion—on word
choice, sentence length, and more. Far more than a grammar checker, ClearEdits
enables writers at all levels to increase the clarity and impact of their communica-
tions with a click of the mouse.

And writers can configure ClearEdits to catch the problems that plague their writing
most, to get highly relevant feedback. Based on time-tested techniques for improv-
ing business and professional writing, ClearEdits helps writers learn while they
work.

ClearEdits is part of the ClearWriter® suite of writing improvement products. Clear-
Writer includes instructor-led workshops, web-based courses, and editing software.

Visit www.clearwriter.com to learn more about ClearWriter.

This document has four sections:

• Using ClearEdits Clean Up

• Tips for using ClearEdits Clean Up

• Note on ClearEdits editing categories

• Terms of use

USING CLEAREDITS CLEAN UP
When you install ClearEdits Clean Up, two buttons—“Clean Up” and “Display PDF
Manual”—will be placed on your Word toolbar in Word 2003 and older. 
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If this toolbar does not appear, you can select it by going to “View” and then “Tool-
bars,” and then checking ClearEdits. In Word 2007, the buttons will appear on the
“Add-ins” tab.

Reviewing ClearEdits’ suggestions

For Word 2002 and newer the comments should appear on the margins of your pages.
For Word 2000 and older, comments will appear when you move your mouse
pointer over the highlighted text. You work directly in the document to quickly
assess whether to accept each suggestion.

Consider ClearEdits’ suggestions carefully—depending on how you have used a word,
not all suggestions will be appropriate in all circumstances. As you edit your doc-
ument following ClearEdits’ writing improvement tips, don’t worry if your new text
is in color or has an outline—that will disappear when you run “Clean Up.” 

Clean Up

After you have reviewed ClearEdits’ suggestions you can remove all the editing marks by select-
ing “Clean Up.” This will not undo the changes you have made to your document; it removes only
the boxes, colors, comments, and highlighting.

ClearEdits Clean Up User Guide

If you have questions while using ClearEdits Clean Up, click on the “Display PDF Manual” link on
the Clean Up toolbar to view this ClearEdits Clean Up User Guide.

TIPS FOR USING CLEAREDITS CLEAN UP
You must enable “screen tips” and “animated text” in Microsoft® Word for ClearEdits’ suggestions
to display in your document. For Word 2003 and older, go to the “Tools” menu, then select
“Options,” then select the “View” tab. Ensure these options are turned on under the “Show” cat-
egory. In Word 2007, click the Microsoft Office button. Select the tab for “Popular.” Under “Screen-
Tip” style, choose “Show feature descriptions in “Screen Tips.” Now select the tab for “Advanced.”
Under the “Show document content” heading, ensure that “Show animated text” is checked. 

For Word 2003 or newer, set Word to use balloons in Print and Web layout. For Word 2002 and 2003,
select “use balloons” under “Tools,” “Options,” “Track Changes” tab. If you see balloons related
to formatting after you run ClearEdits (a balloon indicating the font color, for example), you can turn
them off. Go to the “View” menu, then select “Toolbars,” then select “Reviewing” to activate the
toolbar. Then on the toolbar deselect  “Formatting” from the drop-down menu for “Show.” For Word
2007, under the “Review” tab, select “Balloons.” Make sure that either “Show Revisions in Balloons”
or “Show Only Comments and Formatting in Balloons” is checked.

For Word 2000 and older, ClearEdits’ suggestions will be in a comment balloon that is displayed
when you move your mouse pointer over a highlighted word or phrase. For Word 2002 or newer,
ClearEdits’ comments will appear in balloons in the margin of your page if you are in Print Layout



view (select this option from “View”). 

For additional support and troubleshooting, or to purchase a copy of ClearEdits 3.1, visit our web
site at www.clearwriter.com.

NOTE ON CLEAREDITS EDITING CATEGORIES
ClearEdits flags suggestions in a number of editing categories (selected by the writer). The text that
follows describes the possible editing categories.

Standard Edits: Core Edits

Unnecessary words (to cut). Unnecessary words draw a reader’s attention from the important
words and ideas. 
Examples: actually, basically, namely, mainly

Dubious words (to change). Dubious (abstract) words or phrases are less effective than words
or phrases that are more concrete, more familiar, or more conventional. 
Examples: latter Ô last, second

ergo Ô so, thus, therefore

Overweight words (to lighten). Overweight words obscure. Lightening the text can give
prominence to important words and ideas. 
Examples: are capable of Ô can

for the purpose of Ô for, to

Weak verbs (to strengthen). Weak verbs—idle, common verbs such as “do,” “have,” “make,”
“provide,” and “serve”—often supplant a working verb, which becomes a noun. ClearEdits sug-
gests transforming that noun or another word later in the sentence into a stronger verb. 
Examples: do a study of Ô study

make changes in Ô change

“-ion” words (to switch to verbs or concrete nouns). Words ending in “-ion” often mark
phrases that have manipulated a simple verb into a cumbersome noun construction. For exam-
ple, ClearEdits suggests changing “The repetition of a word increases its power in the sentence”
to “Repeating a word increases its power in the sentence.” 

Standard Edits: More Edits

Compare seeming synonyms. Seeming synonyms are often-misused words. ClearEdits helps
you select the right word for your intended meaning.
Examples: comprise vs. include

which vs. that

Flag too many “Ands.” Sentences with many “Ands” might be too long or too complicated.
ClearEdits inserts a comment at the end of sentences that deserve a second look.
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Vector Edits

Vector Edits direct you to words and suffixes that signal some of the most common changes to
consider in your writing. They point you to “and,” “-ed,” “of,” “which,” and “-ion.” When combined
with the Standard Edits, Vector Edits suggest nearly 90% of the changes that experienced editors
make in a first editorial pass, before getting down to the substance. 

Search for “AND”

Leave as is or consider one of the following

• Trim a word or phrase

From: first and foremost
To: first

• Break a long sentence in two

From: The speaker, though paid $15,000 to attend the conference, probably felt that the egg
on his face was not worth it, and he must still be wondering how a person once all-powerful
could have been subjected to such ignominy. 
To: The speaker, though paid $15,000 to attend the conference, probably felt that the egg on
his face was not worth it. He must still be wondering how a person once all-powerful could
have been subjected to such ignominy. 

• Make phrases parallel

From: Aides on Capitol Hill talk about running the country and the manipulation of constituents. 
To: Aides on Capitol Hill talk about running the country and manipulating constituents.

• Arrange series from short to long

From: Pieces of eight, Venetian ducats, and doubloons poured onto the floor. 
To: Doubloons,Venetian ducats, and pieces of eight poured onto the floor.

• Convert what follows one verb to a leading part

From: She is pragmatic and determined and has plenty of experience helping run opera hous-
es in Britain and France. 
To: Pragmatic and determined, she has plenty of experience helping run opera houses in Britain
and France.

• Convert one clause to a leading part

From: Americans are struck by an annual outbreak of filial sentiment on Mother’s Day, and

they make more long-distance calls on Mother’s Day that on any other day of the year. 
To: Struck by an annual outbreak of filial sentiment, Americans make more long-distance
calls on Mother’s Day than on any other day of the year.

Search for “–ED”

Leave as is or consider one of the following

• Trim fat

From: People who are located in towns Or: people located in towns 
To: People in towns

• Simplify an adjective

From: centralized control 
To: central control

• Switch to a comparative adjective
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From: increased effort 
To: more effort

• Switch from participle to verb

From: is engaged in 
To: engages in

• Switch from passive voice to active

From: That book was published by Knopf. 
To: Knopf published that book.

• Switch from passive voice to leading (-ing) form

From: The election of new civilian governments at municipal, state, and national levels was capped

by the election of Olusegun Obasanjo as president. 
To: Capping the election of new civilian governments at municipal, state, and national levels
was the election of Olusegun Obasanjo as president.

Search for “OF”

Leave as is or consider one of the following

• Switch to a possessive

From: the contents of the book

To: the book’s contents

• Delete it, possibly THE as well

From: some of the countries 
To: some countries

• Switch abstract noun to verb form

From: the production of steel 
To: producing steel

• Superfluous nouns

From: The purpose of this report is to review 
To: This report reviews

Search for “WHICH”

Leave as is or consider one of the following

• Switch to THAT for a defining clause

From: The software which the company just released is likely to be a big improvement. 
To: The software that the company just released is likely to be a big improvement.

• Punctuate the WHICH clause (if it’s adding information about the noun but not defining it)

From: The new software which the company has been developing since 1999 is now available. 
To: The new software, which the company has been developing since 1999, is now available. 

• Delete WHICH and the verb

From: A good solution, which is known as ellipsis, is to delete the which and the auxiliary verb—
which is a solution that works best with is and are. 
To: A good solution, known as ellipsis, is to delete the which and the auxiliary verb—a solu-
tion that works best with is and are.

• Pull the WHICH clause to the front of the sentence (without WHICH and its verb)

From: The software, which was just released, is likely to be a big improvement. 
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To: Just released, the software is likely to be a big improvement. 

• Delete the WHICH clause (if it adds little)

From: The main problem, which remarkably few writers are aware of, is failing to set off a dis-
pensable clause by punctuation.
To: The main problem is failing to set off a dispensable clause by punctuation. 

• Simplify a heavy construction

From: the manner in which 

To: the way that

• Switch a sentence-opening WHICH to THAT

From: Which is why some commentators have come down hard on lax corporate governments. 
To: That is why some commentators have come down hard on lax corporate governments.

Search for “–ION”

Leave as is or consider one of the following

• Switch from Latinate abstraction to Anglo-Saxon equivalent

From: nictitation 
To: wink

• Switch to an –ING word, dropping THE and OF

From: The collection of 
To: collecting

• Switch from a weak verb and abstract noun to a stronger verb

From: serves to make reductions 
To: reduces

My Edits

Writers (or organizations) can add entries from their personal or corporate style guides and customize
ClearEdits to suit their needs. And they can preface My Edits with a word or phrase for easy iden-
tification (for example, “Bruce’s rules”).

For further support, please contact us at support@clearwriter.com.

TERMS OF USE
ClearEdits® Clean UpTM

Definitions

ClearWriter® is a family of writing improvement products that includes an online course library,
instructor-led workshops, and ClearEdits editing software. ClearWriter products were created and
are wholly owned by Communications Development Incorporated.

“ClearEdits” is software that applies powerful editing techniques to electronic documents and scores
writing on clarity and conciseness. ClearEdits works with Microsoft® Word and Outlook®. “ClearEdits
Clean Up“ is software that removes ClearEdits’ suggestions from a document even if the computer
does not have ClearEdits installed. “User” means each person who uses ClearEdits Clean Up. 
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Limitation on use

You are expressly prohibited from using ClearEdits Clean Up to provide editing or proofreading
services to third parties (commercial use). In using ClearEdits Clean Up, you agree to be bound
by the conditions in this Terms of Use. You may not use ClearEdits Clean Up for any unlawful purpose.

These Terms of Use supersede any prior agreements except a pre-existing site license.

Disclaimer of warranty; limitation of liability

(a) User expressly agrees that use of ClearEdits Clean Up is at user’s sole risk. Communications Devel-
opment does not warrant that ClearEdits Clean Up is error-free; nor do we make any warranty as to
the results that may be obtained from use of ClearEdits Clean Up, or as to the accuracy or reliabili-
ty of the results of such use.
(b) ClearEdits Clean Up is provided on an “as is” basis without warranties of any kind, either
express or implied, including, but not limited to, warranties of title or implied warranties of mer-
chantability or fitness for a particular purpose, other than warranties that are implied by and inca-
pable of exclusion, restriction, or modification under the laws applicable to this agreement.
(c) This disclaimer of liability applies to any damages or injury caused by any failure of performance,
error, omission, interruption, deletion, defect, delay in operation, computer virus, theft or destruc-
tion, or unauthorized access to, alteration of, or use of record, whether for breach of contract, tor-
tious behavior, negligence, or under any other cause of action.
(d) In no event will Communications Development, or any person or entity involved in creating, pro-
ducing, or promoting ClearEdits Clean Up or ClearEdits Clean Up materials, be liable for any damages,
including, without limitation, direct, indirect, incidental, special, consequential, or punitive damages
arising out of the use of or inability to use ClearEdits Clean Up. User hereby acknowledges that the
provisions of this section shall apply to this and all subsequent versions of ClearEdits Clean Up.
(e) In addition to the terms set forth above, Communications Development shall not be liable, regard-
less of the cause or duration, for any errors, inaccuracies, omissions, or other defects in, or untime-
liness or unauthenticity of, the content contained within ClearEdits Clean Up, or for any claims or
losses arising therefrom or occasioned thereby. Communications Development shall not be liable
for any third-party claims or losses of any nature, including, but not limited to, lost profits and puni-
tive or consequential damages. Communications Development does not warrant or guarantee the
timeliness, sequence, accuracy, or completeness of this information.

Copyright 

ClearEdits Clean Up is the property of Communications Development, which holds all rights to
ClearEdits Clean Up. By your agreement to be bound by these Terms of Use, you have a nonex-
clusive license to use ClearEdits Clean Up for your personal, noncommercial use only. You agree
not to modify, reproduce, sell, publish, broadcast, or otherwise circulate ClearEdits Clean Up. 

Trademarks

ClearEdits Clean Up, ClearEdits, the ClearEdits logo, ClearWriter, and the ClearWriter logo are trade-
marks of Communications Development. All rights reserved. These trademarks may not be used
in connection with any product or service that is not provided by Communications Development,
in any manner that is likely to cause confusion among customers, or in any manner that disparages
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or discredits Communications Development. For any questions or requests other than copyright issues,
please contact support@clearedits.com.
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